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INTRODUCTION  

The ExamView® Assessment Suite 5.0 (including the Test Generator and Test 
Manager) is a comprehensive solution for creating, administering, and scoring tests. 
With the new version, it is easier than ever to prepare paper and online tests. The 
software includes many features to save you time and generate information to assess 
and improve student performance.  

 
Use the ExamView Test Generator to… 
 

• Create a paper test in less than five minutes.  

• Print multiple versions of the same test.  

• Enter your own questions. 

• Prepare an online test, study guide, and worksheet. 

• Upload tests to WebCT and Blackboard. 

 
Use the ExamView Test Manager to… 
 

• Create a class roster. 

• Automatically score a paper test using a scanner.  

• Administer and score an online test. 

• Prepare a variety of useful class and student reports. 

 
Our mission is to enhance the learning process by providing superior products for 
students and educators. We believe that the ExamView Assessment Suite can truly 
enhance your classroom experience. 
 
One of the reasons our software is so widely used in classrooms is that we include 
educators and students in the design process. We invite you to share your experiences 
and feedback with us so we can make our products even better. Please email your 
comments to support@fscreations.com. 
 
To learn more about our products, visit our website at www.fscreations.com. 
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System Requirements 
To use the ExamView Assessment Suite, your computer must meet or exceed the 
following requirements: 
 
Windows 
• PC with Pentium II 120 MHz or higher processor 
• Microsoft Windows 98 or later operating system   
• 32 MB available memory for application (64 MB recommended) 
• CD-ROM drive 
• Monitor capable of displaying 16-bit color with 800 x 600 resolution 
• 24 MB of available hard drive space 
• Mouse 
• Internet connection to access the test-hosting features 
 
 
Macintosh 
• PowerPC 120 MHz or higher processor 
• OS X 10.2 or later operating system 
• 32 MB available memory for application (64 MB recommended) 
• CD-ROM drive 
• Monitor capable of displaying 16-bit color with 800 x 600 resolution 
• 24 MB of available hard drive space 
• Mouse 
• Internet connection to access the test-hosting features 

 
Note: The ExamView Assessment Suite includes a separate program called the 
ExamView Test Player that you can use to deliver online tests on your local area 
network. The system requirements are the same as those shown above except that the 
application requires a minimum of 16 MB available memory for the application and 8 MB 
of hard drive space. 
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Installation Instructions 
Follow these steps to install the ExamView Assessment Suite. The installer will create 
an ExamView folder and these subfolders: Banks, Tests, Scanners, and Classes. If you 
received the software from a publisher, the installer will automatically copy the 
publisher-supplied question banks to a new folder within the Banks folder. 
 
 
Windows 
1. Insert the ExamView disc into the CD-ROM drive of your computer.  

 If the autorun feature is enabled on your computer, a window will automatically 
appear on your screen. Click the Install button and skip to step 5. If the autorun 
window does not appear, proceed to step 2. 

2. Click the Start button and choose Run. 

3. In the Run window, type d:\setup.exe, replacing d with the drive letter that 
corresponds to the drive where the setup file is located. 

4. Click the OK button. 

5. Follow the instructions that appear on your screen. 
 
Note: To uninstall the ExamView software, choose Settings – Control Panel from 
the Start menu. Select Add or Remove Programs. Removing the program does not 
delete any banks or tests. You must manually remove those files. 

 
Macintosh 
1. Insert the ExamView disc into the CD-ROM drive of your computer.  

2. Open the installer window, if necessary. 

3. Double-click the ExamView installer icon. 

4. Follow the instructions that appear on your screen. 
 
Note: To uninstall the ExamView software, simply delete the program folder. 
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Getting Started 
After you complete the installation process, follow the instructions below to start the 
software. Start the ExamView Test Generator if you want to create a test, open an 
existing test, create new questions, or work with a question bank. Use the ExamView 
Test Manager to create a new class roster, assign an online test to a class, get results 
from an online test, score a paper test using a scanner, or print a report. 
 
ExamView Test Generator 
1. Windows: Click the ExamView Test Generator shortcut on your desktop. If you do 

not have a shortcut, click the Start button. Highlight the Programs menu and locate 
the ExamView Pro Test Generator folder. Select the ExamView Test Generator 
option. 

 Macintosh: Click the ExamView Test Generator 
icon in the dock. If you do not see this icon, locate 
the ExamView Pro folder on your hard drive. 
Double-click the ExamView Test Generator icon. 

Use the 
ExamView Test 
Generator to 
create a test or 
work with a 
question bank. 
 

2. The first time you run the software, the program 
prompts you to enter your name, school/institution 
name, and city/state. Enter the requested 
information. 

3. Choose one of the options in the Startup menu.  

Each time you run the ExamView Test Generator program, the program displays 
the Startup menu. You can choose to create a test using the Test Builder or enter 
your own questions using the Question Bank Editor. 

  

All of the figures 
are from the 
Windows version. 
Except for a few 
minor differences, 
the Macintosh 
screens are 
identical. 
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ExamView Test Manager 
1. Windows: Click the ExamView Test Manager 

shortcut on your desktop. If you do not have a 
shortcut, click the Start button. Highlight the 
Programs menu and locate the ExamView Pro Test 
Generator folder. Select the ExamView Test 
Manager option. 

 Macintosh: Click the ExamView Test Manager icon 
in the dock. If you do not see this icon, locate the 
ExamView Pro folder on your hard drive. Double-click the ExamView Test Manager 
icon. 

Use the 
ExamView Test 
Manager to 
assign an online 
test, get results, 
or print reports. 

2. Choose one of the options from the Startup menu.  

Each time you run the ExamView Test Manager program, the program displays the 
Startup menu. You can choose to start a new class or open an existing class. 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
Help Topics 
Detailed help instructions are always available if you need assistance using the 
ExamView software. Click the Help button or choose the Help Topics option from the 
Help menu to view step-by-step instructions. If you have trouble while you are working 
with the software, you may want to review the troubleshooting tips.  
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CREATE A TEST  

The ExamView Test Generator program provides all the tools you need to create a 
paper test or an online test from your own questions or from those provided by a 
publisher. You can use the QuickTest Wizard to select the questions for a test, or you 
can use one or more of the other question selection options.  

 

After you create or build a test, you can change the instructions, reorder the 
questions, change the layout, print the test, or publish an online test. 

 
 
Use the QuickTest Wizard 
If you want to create a test quickly with randomly selected questions from one or 
more question banks, use the QuickTest Wizard. The wizard guides you through the 
step-by-step process of selecting questions for a new test. 
 
To create a test with the QuickTest Wizard… 

You can also click 

the  button in 
the toolbar to start 
the QuickTest 
Wizard. 
 

1. Launch the ExamView Test Generator. A startup 
window with several options will appear. Choose t
Create a new test using the QuickTest Wizard 
option. 

he 

2. Name your test. 

3. Select the question banks from which you want to choose questions. 

4. Identify how many questions of each type you want on your test and click the Finish 
button. 

 
That’s all there is to it! If you want, you can customize the appearance of your test 
using the many formatting options or you can select additional questions.  
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Build a New Test 
The ExamView Test Generator offers several question selection options to create a 
new test. You can use the QuickTest Wizard or one of the other six options. The option 
you choose depends on your particular needs. For example, you can select questions 
by viewing the actual questions and deciding which ones to include on your test. Or, 
you can select questions by learning objective or standard. 
 
To build a new test… 

1. Launch the ExamView Test Generator. A startup 
window with several options will appear. Choose t
Create a new test option. 

he 

2. Name your test. 

3. Choose one of the question selection options from 
the Select menu, or click the corresponding toolbar button.  

You can also click 

the  button in 
the toolbar to 
create a new test. 
 

Select Randomly - Choose this option if you want to select questions 
randomly. You can choose how many questions you want for each question 
type (e.g., multiple choice, true/false, short answer, etc.). 

Select from a List – If you have a printout of your question banks, you can 
manually review the questions and choose the ones you want to include on a 
test by writing down the question numbers. Then, use this option to select the 
question numbers from a list. 

Select While Viewing – Use this selection method if you want to view the 
questions and make your selections one at a time while viewing them. 

Select by Standard – If your questions include learning objectives, local 
standards, state standards, or national standards, use this option to easily 
select questions based on this information. 

Select by Criteria – Choose this option to select questions that match criteria 
you enter. For example, you can select all of the multiple choice questions 
that cover a certain topic and include specific keywords. 

Select All – Choose this option if you want to quickly select all of the questions 
in a bank or group of banks. 
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4. After you choose a question selection option, identify which question banks you 
want to use to create the test.  

Highlight one or more question banks and click the Select button. The question 
banks you choose appear in the lower portion of the window. Click the Next button 
to move to the next step.  

Note: If the question bank(s) you want does not appear in the list, click the Folder 
button to locate the question bank(s). 

 
 
 

 

 

 

 

 

 

 

5. Use the options provided to select the questions 
that will appear on your test. If you need help 

using any of the 
selection options, 
click the Help 
button for detailed 
instructions. 

Depending on which question selection option you 
chose, the ExamView Test Generator displays a 
window with the options you need to build a test. 

6. Change the appearance of the test, print the test, 
or publish it online. 

7. Save the test. 
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Customize the Appearance of a Test 
ExamView Test Generator includes numerous features that allow you to customize the 
appearance of a test to your exact specifications. A few of the more popular options 
are listed here, but you can refer to the help topic Customizing the Appearance of a 
Test for a complete list. 
 
Answer Space 
Depending on how your students will complete the test, you can turn on or off space 
for answers. For example, if you want your students to write the answers on the test 
next to each question, you can provide space to do so. If your students will be using a 
bubble sheet or a separate piece of paper, you can show only the questions. Choose 
Layout from the Test menu. Set the corresponding options in the Leave Answer Space 
for area of the layout window. 
 
 
Reordering Questions 
Changing the order of questions is a snap. Just choose 
Reorder from the Question menu, and you can drag 
and drop the questions to your liking. Note, however, 
that questions must remain grouped by question type. 
You cannot move a single true/false question to a 
position after the multiple choice questions. Instead, 
you must move the entire group of true/false 
questions. 
 
If you want to scramble the questions, choose 
Scramble from the Question menu. From there, you can choose to scramble sections, 
questions, and the answer choices in multiple choice and multiple response questions. 

You can manually 
reorder or scramble 
questions. Also, 
when you print a 
test, there is an 
option to scramble 
the questions. 

 
 
Replace Font 
If you want to change the font of your entire test, choose Replace Font from the Edit 
menu. Select the fonts and sizes you want to use, and click the Replace All button. All 
questions in your test will instantly update with the newly selected font choices. 
 
Note: If you use the Replace Font option to replace a font, it is best to replace one 
font (e.g., Times New Roman) with another (e.g., Arial). Do not choose to replace all 
fonts with another font. This could cause unintended results such as replacing symbols 
or other special characters (e.g., Symbol). 
 
 
Adjust Multiple Choice 
Do you need to alter a multiple choice test for a special-needs student? Choose Adjust 
Choices/Columns from the Question menu to adjust your test. You can instantly 
reduce the number of choices in all of your multiple choice questions.  
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Layout and Style 
Several state and national test styles are built into the ExamView Test Generator. 
Instantly format your test by choosing a style from the Style Gallery. For example, if 
you want to format your test to look like the PSAT, choose Style Gallery from the Test 
menu. Select the PSAT option and click the OK button. 
 
If you do not see a style that suits you in the Style Gallery, you can customize the test 
with the Layout and Style commands. Choose Layout from the Test menu, and set the 
layout options. Then click the Style tab and choose your fonts and styles. The figure 
below shows an example of a test with a customized bubble sheet style. 
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Print a Paper Test 
After you create or open a test, you can print a paper test in just a few simple steps. 
When you choose to print a test, the ExamView Test Generator prints the test and 
the answer key exactly how it appears on screen.  
 
To print a test… 

1. Choose Print from the File menu, or click the  toolbar button. 

2. Set the print options. 

If you choose 2 or more versions of the test, you can choose to scramble the 
questions using several options. If the test includes dynamic questions, the 
ExamView Test Generator can calculate new values for each test. 

As part of the test, you can print an answer strip to make it easier to score paper 
tests, a bubble sheet form so that students can record their responses, and a 
version map that identifies how questions align on each version of a test.  

 

 

 

 

 

 

 

3. Click the OK button. 
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Publish an Online Test 
The ExamView Test Generator lets you publish a test in a variety of online formats. 
Regardless of the online testing option you choose, the steps to build a test are the 
same as those you use to create a paper test. The online testing options are listed 
below. 
 
Online testing options… 

• Create an online test on your local area network (LAN). 
• Publish a test using the ExamView Test-Hosting Service. 
• Save the test as an HTML document that you can post to your own website. 
• Export the test for use with your WebCT or Blackboard course management 

system. 
• Publish a test to a third party’s website.  

 
The online testing format that you choose depends on your specific needs. Refer to 
the other sections in this manual for a complete description of the various options. 
Detailed instructions are available to guide you through the process of publishing an 
online test. 
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ENTER YOUR OWN QUESTIONS  

When you build a test using the ExamView Test Generator, you do so by selecting 
questions from question banks. A question bank (or bank) is a collection of questions 
and all of the related items (pictures, equations, learning objectives, standards, etc.) 
stored in one file. Each question bank may contain up to 250 questions, but you can 
have an unlimited number of banks. Typically, questions are organized into banks by 
chapter or lesson. 

 

Using the ExamView Test Generator, you can… 

• Enter new questions or edit existing questions. 
• Copy and paste questions from another source. 
• Import questions from Word or an RTF file (with the EV Import Utility).  

 

IMPORTANT: You can create a new question or edit a question while building a test. 
However, editing a question after it is included on a test does not change the original 
question in the question bank. You must edit questions or add new ones in a question 
bank to make those questions available when you build your tests. 

 
 
Question Bank Basics 
If you have not used the ExamView Test Generator to create your own questions, 
there are a few things to consider before you get started. For example, you can 
include more information than just the question (e.g., answer, learning objective or 
standard, student feedback, etc.). Take a few 
moments to review the information presented here 
before you begin the next section. 

You can use a 
bimodal question 
as a short answer 
or a multiple choice 
question on a test. 
 

 
 
Question Types 
When you create your own questions, you can include 
one or more of the following question types. 
 

True/False 
Modified True/False 
Multiple Choice 
Multiple Response 
Bimodal 

Yes/No 
Numeric Response 
Completion 
Matching 
Short Answer 

Problem 
Essay 
Case 
Other 
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Question Information 
Questions can include optional information that is useful when creating a test. For 
example, you can include learning objectives (or standards) and then select questions 
based on those objectives. You can also use this 
information to generate class and student reports. You 
can enter any or all of the following information with 
each question. 

Use the pipe ( | ) 
character to enter 
more than one 
data element 
such as a state 
standard – 
MA3-1.2 | MA4-1. 

 
 
Difficulty 
Reference 
Learning Objective 
National Standard 

State Standard 
Local Standard 
Miscellaneous 

Topic 
Keywords 
Notes 

 
 
Student Feedback 
If you use the ExamView Assessment Suite to deliver online tests, you can include a 
rationale and student feedback for each objective-based (e.g., multiple choice) 
question. As a result, you can set up your online tests to display feedback for incorrect 
responses.  
 

For paper and 
online tests, you 
can print a report 
with the rationale 
for each item a 
student answers 
incorrectly. 
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Narratives 
A narrative is a table, a descriptive passage, a special instruction, a picture, or other 
information that can be attached to (or linked to) one or more questions. All questions 
linked to the same narrative print together as a group on a test. Possible uses for a 
narrative include a reading passage, map, chart, or photo. 

 

Images 
You can easily insert an image (e.g., graph, map, photo, etc.) into a question or an 
answer. Or, you can copy and paste an image from another program. Whichever option 
you use, be sure to consider the size and readability of 
the image.  You can edit a 

question and 
double-click an 
image to see how 
much space it 
requires. You can 
also reduce the 
color setting of 
the image. 

 

Color images and photos can use a lot of memory that, 
in turn, increase the size of the test or question bank 
file. For example, a single color photo can be 1-2 MB. 
For paper tests, the size of an image is not that critical. 
However, the image size does affect online tests. 
Imagine students downloading a test via the Internet 
that includes three or four photos. If you use color 
images, use the lowest possible resolution.  

 

If you plan to include an image in a question, you should check the image for 
readability. Can you read the information on your screen and on paper? If you create 
your own art, use a larger font for text that appears as part of an image.  For best 
results and smaller file sizes, use black and white or 256-color images. 

 

Other Issues 
If you create your own questions or edit existing questions, consider these additional 
guidelines.  
 
When you create your own questions… 

• Do not write questions that refer to another question or depend on a particular 
question order. Remember that you can scramble questions on a test. And, if 
you randomly choose questions, you may not get all of the questions you need.  

• Use tables, not tabs, if you need to create tabular material. Tables work much 
better, especially for online tests. 

• Use standard fonts (e.g., Times New Roman, Arial, etc.). If you use other fonts, 
you may have difficulty sharing the question banks with someone who does not 
have the fonts you used. This can be a problem for online tests too. 

• For multiple choice and multiple response questions, be sure to set the scramble 
options for questions that include choices such as All of the above or None of 
the above. You would not want one of these choices to appear as choice a or b. 

• Do not worry about entering the instructions for the questions. ExamView Test 
Generator automatically includes the instructions when you create a test. 
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A Hands-On Tutorial 
This section provides a tutorial that will guide you step-by-step through the entire 
process to create a question bank using the ExamView Test Generator. You will learn 
how to create a variety of question types, save the bank, use a narrative, insert art, 
enter question information, and print a question bank. 
 
Create a New Question Bank 
1. Start the ExamView Test Generator program. 

2. Choose Create a new question bank from the Startup menu. 

If you are currently working in the test builder, choose Switch to Question Bank 
Editor from the File menu and then select the option to create a new bank. 

 

 

 

 

 

 

 

 

 

3. Name the question bank ExamView Sample Bank and click the OK button. 

An empty question bank page (except for the title) appears on your screen. If you 
want to edit the title, simply double-click it and change the title. 

 
 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 16   



  
  

Enter True/False Questions 

1. Click the New button at the bottom of the window. 

2. Choose True/False and click the OK button. 

The question entry screen for a true/false question will appear. Depending on the 
question type, the entry screen provides different options. For example, the 
multiple choice screen includes space to enter each choice. 

3. Type the following question in the question entry area. 

Using ExamView you cannot create different versions of the same test. 

4. Use the pop-up answer box in the lower right corner of the window to set the 
answer to False. 
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5. Click the Info button at the bottom of the window. 

6. Type Easy for the difficulty, 221-223 for the reference, and click the OK button. 

7. Click the Record button. 

You should see the question you just entered on the 
question bank page. If you do not see the question 
information immediately after the question, choose 
Preferences from the Edit menu. Click the Layout 
tab and select the options to show difficulty and 
reference. 

By default, all 
questions are 
assigned a value 
of 1 point. You 
can change the 
points in the 
Question Info 
window. 8. Proofread the question. If you need to make any 

changes, double-click the question. Or, highlight it 
and click the Edit button at the bottom of the 
window. 

9. Create two more true/false questions using the following information. 
 
 

ExamView gives you almost complete control over the appearance of a test so 
that you can customize it to meet your testing requirements. 
 
ANS: T  DIF: Easy  REF: 245 
 
 
Stylized text, fonts, and special characters cannot be used in a test question. 
 
ANS: F  DIF: Challenging  REF: 237 

 
 
Save the Question Bank 

1. Proofread your work and make any changes as 
needed. Be sure to save 

your question 
bank on a regular 
basis. From time 
to time, make a 
backup of your 
files. 

2. Choose Save from the File menu. 

3. Enter a question bank file name, and select a 
location where you want to save the file. 

4. Quit the program, or continue with the next part of 
this tutorial. 
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Create Multiple Choice Questions with a Narrative 

1. If necessary, start the program and choose to open the question bank for this 
tutorial. 

You can press 
Ctrl+N (Windows) 
or Cmd+N 
(Macintosh) to 
create a new 
question. Or, 
choose New from 
the Question 
menu.  

2. Click the New button, and choose to create a 
multiple choice question. 

3. Enter the following question, answer, and question 
information. 

 
Based on Table 1-1, ExamView 5.0 includes which 
feature? 
 
a.  QuickTest Wizard 
b.  Internet Test-Hosting 
c.  Select by Standard 
d.  All of the above 
 
ANS: D           DIF: Average           REF:  242-245 

4. Set the answer to d. 

5. Choose a-c in the Scramble box to scramble choices a-c only when you create a 
test, and set 1 for the columns. 

6. Click the Narrative button, click New, and enter the following narrative.  

 Use the Table menu to insert a table. If you have time, format the table as shown 
below. Center the information in the last two columns, shade the first row, and 
make the column labels bold. 

  
 ExamView 4.0 ExamView 5.0 

QuickTest Wizard Yes Yes 
Multiple Response No Yes 
Internet Test-Hosting Yes Yes 
Spell Check Yes Yes 
Select by Standard No Yes 

  Table 1-1 

7. Enter EV Table 1-1 for the narrative name and click 
the Record button. It is important to 

use a unique 
name for each 
narrative you 
create. 

8. Click the Done button to return to the question 
entry window. 
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9. Record the question. 

When you record the question, both the question and the narrative appear 
together. 

10. Enter the following question, answer, and question information. 
 

Based on Table 1-1, ExamView 4.0 does not include which feature? 
 
a.  QuickTest Wizard 
b.  Internet Test-Hosting 
c.  Select by Standard 
d.  Spell Check 
 
ANS: C           DIF: Average           REF:  242-245 

11. Click the Narrative pop-up (not the button) and choose the EV Table 1-1 narrative 
to link this question to the table you already created. 

12. Record the question, and be sure to save your work. 
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Enter Completion Questions and Run Spell Check  

1. Choose to create a new completion question. 

2. Enter the following question, answers, and question information. 

Notice that the question has three possible answers. For online tests, students can 
respond with any one of the answers. 

 
ExamView is a computer ____________________ 
that allows you to build paper and online tests. Use the Shift key 

and hyphen to 
create the space 
to write an 
answer. 

 
ANS: 
program 
application 
tool 
 
DIF: Average         REF: 247 
 

3. Enter the next question, answer, and question information. 
 
 

Use the online ____________________ whenever you need additional 
instructions to use the ExamView software. 
 
ANS: help              DIF: Easy            REF: 251 
 

4. After you record the question, choose Spell Check from the Edit menu. 

5. Save your work. 
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Create a Short Answer Question with a Picture  

1. Choose to create a new short answer question. 

2. Enter the following question, answer, and question information; but do not record 
the question. 

 
Describe the picture above. What format is used and how big is it? 
 
ANS:  Student answers will vary depending on the picture used. 
 
DIF: Average            REF: 277 

3. Insert one or two blank lines above the question, and move the cursor to the first 
line. 

4. Choose Picture from the Insert menu, locate a picture, and insert it into the 
question.  

If you cannot find a picture, start a paint program and create a simple illustration. 
Then, copy and paste the picture into the question. 

5. After you insert a picture, double-click the image and choose the Picture tab.  

This window shows the memory size for the image. You can also change the color 
settings here.  

 

. Close the Format Picture windo

 
 
 
 
 
 
 
 
 
 

Remember to 
keep the memory 
size of each 
picture as small 
as possible. 

 

6 w and record the question.  
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Wrap Things Up  

1. Save the question bank. 

2. Print a copy of the questions and review them. 

3. Make any needed changes.  

Remember that you can double-click a question or narrative to edit it. Or, you can 
highlight an item and click the Edit button. 

If you want, switch to the Test Builder using the File menu and choose to create a 
new test. Use the questions you just entered to build your test. Notice that as you 
build the test, the instructions automatically appear. 

4. Quit the program. 
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Copy and Paste Questions 

If you have questions in another format (e.g., word processor, another test generator, 
database, etc.), you can copy and paste questions from that program into the 
ExamView Test Generator. While this is a simple process, it can be time consuming. 
Usually, the copy and paste method is best for just a few questions. 

Note: If you have many questions in a word processor format such as Microsoft Word, 
you can use the import utility to import your questions quickly. Refer to the next 
section for instructions. 
 
To copy and paste questions… 

1. Choose to create a new question in a question bank or a test. 

2. Highlight and copy the text (e.g., from your word processor) that you want to paste 
into a question. 

3. Switch to the ExamView Test Generator question entry window. 

4. Paste the text into the question. 

Depending on the question type, you may have to copy and paste the question 
separately from the answer. However, you can quickly copy/paste multiple choice 
and multiple response questions. Using the SmartPaste option, you can 
automatically copy the choices into the appropriate places in the question entry 
window. 

To use SmartPaste, highlight an entire multiple choice or multiple response 
question including the choices (a. b. c. d. e.) in your word processor and select 
Copy. Switch to the question entry window and press F7 (not Ctrl+V or Paste). Use 
Cmd+P on the Macintosh. 

 
 
 
Import Questions from a Word Processor 

If you have all or most of your questions in a word processor format such as Microsoft 
Word, you can use the EV Import Utility (installed with the other ExamView programs) 
to import your questions into the ExamView Test Generator format very quickly. The 
program includes step-by-step instructions that explain how to import your questions. 
Go to our website (www.fscreations.com) to check for updates to this free utility. 

http://www.examview.com/


  
  

SET UP A NEW CLASS AND ENTER A ROSTER  

The ExamView Test Manager provides the features you need to track results for paper 
and online tests. To begin, you must create a new class. Then, you can manually enter 
the student information or import a roster from another format such as your 
gradebook. Follow the steps in the appropriate section to create a new class and enter 
your roster. 

IMPORTANT:  You do not have to create a new class if you do not plan to track 
student results or give online tests. 
 

Create a New Class 
Before you enter student information, you must create a new class. To do so, you must 
enter information about your class (e.g., class name, class ID, period, and section) and 
yourself (name, ID, school name, school ID, city, and state). Just a few of the fields 
are required. Other fields, such as the password and school ID, are optional.  

To create a new class… 

You can change the 
information at any 
time by choosing 
Class Information in 
the Edit menu. 

1. Launch the ExamView Test Manager. A startup 
window with two options will appear. Choose the 
Start a new class option.  

 If you are already working with the ExamView 
Test Manager, save the current class and choose 
New Class from the File menu. 

2. Enter the class name and other fields as needed.  

3. Enter your name, school name, city, and state. The other fields are optional. 

4. Click the OK button to record the class information. 
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Enter Student Names and IDs Manually 
After you create a new class, the next step is to enter your students. At a minimum, 
you must enter each student’s name and assign an ID.  You may also enter an alias and 
a password. ExamView Test Manager provides an option to show the alias instead of 
the name and ID on reports. You can assign a unique password to each student to use 
when taking an online (LAN) test. 

 

ExamView Test Manager allows you to generate reports using optional demographic 
information such as gender, socio-economic factors, race, and custom fields (e.g., 
instructor, location, etc.). Simply click the More button in the New Student window 
to display the data entry fields to record this information. 

To enter student information manually… 

1. Continue from the previous section where you created a new class. Or, start the 
ExamView Test Manager to begin a new class or open an existing class. 

2. Click the  toolbar button or choose Add New 
Student from the Student menu. The alias and 

password fields 
are optional. 
 
Click More to 
view additional 
student fields. 

3. Enter the student’s first name, last name, and ID. 

 Note: If you plan to use a scanner, use digits only 
(e.g., 520403) for the ID. Most scanner forms 
provide for numeric IDs only.  For online testing, u
unique student IDs across all of your classes. 

se 

4. Click the Next button to record the student. 

 When you click the Next button the program records the student and clears the 
data entry field so that you can enter the next student.  

 

 

 

 

 

5. Repeat steps 3 and 4 to enter all of your students. 

6. Click the OK button when you are finished entering students. 
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Import a Student Roster 
The ExamView Test Manager makes it easy to import your students from another file. 
At a minimum, the file must include the student’s first name, last name, and ID. The 
file must be a text file but can include the fields in any order along with other 
information. In just a few steps you can identify the pertinent information and start 
the import process. 

To import student information… 

1. Start the ExamView Test Manager to begin a new class or open an existing class. 

2. Choose Import from the File menu. 
You can import 
your class roster 
from another 
program such as 
your gradebook. 

3. Select the .txt or .csv file that includes the students’ 
names and IDs. 

4. Click the pop-up menus in the First Data Record from 
File column to identify the data to import. 

5. Click the OK button to import the student 
information. 
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SCORE PAPER TESTS WITH A SCANNER  

Using the ExamView Test Manager, you can easily score student assignments with a 
scanner. Currently, the program supports the following scanners:  Apperson 
Advantage™ 1200 (www.appersonedu.com) and the Pearson/NCS EZData® scanner 
(www.pearsonncs.com). 

 

When you use a scanner to score your students’ tests, you… 

• Save time. 
• Get detailed results data. 

 

Saving time is an obvious advantage. Scanner technology makes it easy to score 
multiple choice, multiple response, and true/false questions. If a test includes both 
objective and open-ended questions, you can score the 
objective questions with a scanner and then manually 
score the open-ended questions, recording the points 
earned for those questions. 

 

The primary purpose of the ExamView Test Manager is 
gathering detailed performance data to help you make 
effective decisions. A scanner provides a means to 
gather the data from paper tests to score your students’ 
work and generate various reports. If your tests include 
learning objectives, state standards, etc., you can then use that information to 
pinpoint areas where individual students need additional help. You can also use that 
data to identify trends for your entire class. 

A scanner makes 
scoring tests and 
quizzes quick and 
easy. And, you 
get detailed 
results for your 
class. 

 

IMPORTANT:  You must use specific forms with the scanners. Go to our website 
(www.fscreations.com) for a complete list of supported scanners.  
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Build a Test and Create an Assignment 
Before you can score a test using a scanner, you must build the test using the 
ExamView Test Generator and then create an assignment in the ExamView Test 
Manager. When you create the assignment, the ExamView Test Manager 
automatically opens the test file and reads the following information for each question 
(if available): answer, reference, learning objective, local standard, state standard, 
national standard, and points.  

To build a test and create an assignment… 

1. Start the ExamView Test Generator, build a test, and save it. 

Scanning works only with objective questions such as multiple choice, multiple 
response, and true/false. However, your test can include open-ended questions 
such as short answer or essay. You must manually score those questions and record 
the points. 

Note: If you plan to administer multiple 
(scrambled) versions of a test, create one 
version, print it, and then save the file. 
Scramble the test to create the next version, 
print it, and save the test. For each unique test, 
you must create a separate assignment. 

If your test includes 
objective and open-
ended questions, 
place the objective 
questions (e.g., 
multiple choice) at 
the beginning of the 
test. 

2. Start the ExamView Test Manager and choose 
to open a class. 

3. Click  or choose Create New Assignment 
from the Assignment menu. 

4. Enter the assignment name, category, term, and date. 

 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 29   



  
  

5. Choose the Paper test scored manually or with a scanner option to identify how 
you will administer the test. Click the Next button. 

6. Select the file name that corresponds to the test 
you created in the ExamView Test Generator. 
Click the Next button. 

You can click the 
Preview Test 
button to make sure 
that you are 
selecting the correct 
test. 

 When you click the Next button, the program 
reads the answer key and other information that 
it needs to scan and score the test.  

 Note: If necessary, click the Folder button to 
locate your test.  

7. Review the summary information, and click the Finish button to complete the 
process. 

After you create the assignment, it appears in the ExamView Test Manager work 
area. Notice the shaded area in the figure below. The program shows the 
assignment title, date, category, term, and possible points. A placeholder (--) 
appears for each score.  

You will learn how to get results from a scanner in the next section.  
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Get Results from a Scanner 
After you create an assignment, the next step is to administer the test and scan the 
forms to get the results into the ExamView Test Manager. Scanning the forms reads 
the students’ responses for each question. The program stores the information for 
each student and automatically calculates each score based on the point values 
assigned to the questions. 

 

IMPORTANT: You can only score objective questions (e.g., multiple choice, multiple 
response, yes/no, and true/false) using a scanner. However, your test may include 
open-ended questions that you can score manually using the Edit Scores option. 

To get results from a scanner… 

ExamView Test 
Manager includes 
the capability to get 
results from paper 
and online tests. 
 

1. Launch the ExamView Test Manager and open 
the class. 

2. Select (highlight) the assignment that you will be 
scoring. 

3. Click the  toolbar button, or choose Get 
Results from Scanner from the Assignment 
menu.  

4. Select the scanner and form. 

5. Set the port to which the scanner is connected (if necessary), or click the Detect 
Scanner button to automatically set the port. 

6. Set the beginning question number. 

7. Click the Next button to move to the next screen. 

8. Scan the forms.  

9. Click the Finish button to stop scanning. 

General Notes… 
• Verify that the scanner is connected properly before you try to scan the forms. 

If you have trouble with the scanner, contact the manufacturer for support. 
• You must use forms specifically designed to work with the ExamView Test 

Manager software. Go to our website (www.fscreations.com) for more 
information. 

• You may include up to 100 objective questions on a test. If you have more than 
100 questions, divide the test into two parts and create separate assignments.  
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• Place the objective questions at the beginning of the test and number the 
questions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.). 

• If you have problem with a form, you can make corrections and then re-scan it. 
If necessary, you can manually enter the points earned. 

• You can use forms for several assignments. For example, you can administer and 
scan a quiz with 10 questions. For the next quiz, set the beginning question 
number to 11 and assign your students to fill in the bubbles for questions 11-20.  

• You can include matching questions, but the choices are limited to 5 choices (A-
E). Or, you can include matching questions and score the questions manually.  

• The software allows you to get results for an assignment from multiple sources. 
For example, you could administer a paper test to part of the class and an 
online test to other students. 

• You can scan forms in multiple sessions.  
• If there are problems with a student’s form: missing responses, multiple 

responses, out of range (e.g., entering an E if only A-D valid), etc., an asterisk 
(*) will appear next to that student’s name. Click the Stop Scanning button, 
highlight the student’s name, and click the Edit button. You can change the 
response for any item. Click the Resume Scanning button to continue. 

 
Apperson Advantage 1200 Notes… 

• If the scanner becomes unresponsive, click the Stop Scanning button, press the 
Reset Options button (located on the scanner), and then click the Resume 
Scanning button. If that does not solve the problem, cancel the scanning 
process. Turn the scanner off; turn the scanner on; and try to scan the forms 
again. 

• The Apperson scanner prints the percentage score on the scanner form. For tests 
with only objective questions all set to 1 point, the score will be correct. If your 
test includes open-ended questions, the score printed on the form will not 
reflect the open-ended questions. Unfortunately, there is no way to turn off 
printing. However, you can remove the print cartridges. 

 

Pearson/NCS EZData Notes… 

• If the status light turns an orange color, contact the manufacturer for 
assistance. A problem may occur if there is a conflict between the scanner and 
another hardware device. 

• If you notice that the information is regularly misreading student responses, 
follow the manufacturer’s guidelines for cleaning the scanner. 

• You must use forms specifically designed the EZData scanner. Visit our website 
(www.fscreations.com) for information. 
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ADMINISTER ONLINE TESTS ON YOUR LOCAL AREA NETWORK  

The ExamView Assessment Suite includes all of the tools you need to create and 
administer online tests on your local area network (LAN). Use the online testing 
features to save time grading tests and generate the information to improve student 
performance. 

You can create online tests that anyone can take using your local area network (LAN), 
or you can assign a roster to an online test. For example, you can use the ExamView 
Test Generator to create self-grading practice tests (or study guides) that provide 
feedback for incorrect responses. You can also use this testing option to administer 
chapter tests, quizzes, benchmark tests, homework, and worksheets. Then, use the 
ExamView Test Manager to get results from an online test and produce reports. 

 

Before You Begin  
Before students can take tests using your local area network (LAN), you must get ready 
for online testing.  

1. Talk to your network administrator to secure space 
on your local area network to put the online tests. Talk to your 

network 
administrator to 
get everything 
set up before you 
publish an online 
test. 

You and your students both need read/write (full) 
access to the network folder. 

2. Ask your network administrator to install the EV Test 
Player on your network and to place a shortcut on 
each workstation to access the program. Or, you can 
install the player program on each computer. 

 Advanced:  For the Windows version of the EV Test Player, you can create a 
shortcut for the program and set the target properties to include the following 
options. For example, set the target to c:\examview\evpro.exe /nobrowse. 

 /nobrowse This option turns off the option for students to change the path 
(or location) of the tests. 

 /noprefs This option directs the program not to write the preferences to 
the local computer. 

 /testpath= This option allows you to set the default path for the tests. 

3. Start the ExamView Test Generator, choose Preferences from the Edit menu, and 
set the default online (LAN) path to the location on the network.  
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Create an Online (LAN) Test without a Roster  
You can publish an online test with or without a roster for your students to take on 
your local area network (LAN). If you choose to publish a test without a roster, the 
program automatically scores the test. Anyone may take the test; however, the results 
are only available immediately after a student completes a test. No results are stored 
in the ExamView Test Manager, and you will not be able to prepare any student/class 
reports. 

To create and publish an online (LAN) test that anyone can take… 

1. Start the ExamView Test Generator and create or 
open a test. 

2. Click  or choose Publish Online Test from the 
File menu. 

3. Enter a test title. 

4. Choose the Publish the test to a local network for 
use with the ExamView Player option and click the Ne

Results are not 
stored for online 
tests without a 
roster. These 
tests are great 
for practice tests 
and homework. 

xt button. 

 

 

 

 

 

 

 

 

5. Select the Allow access to anyone option and click the Next button. 

6. Follow the steps to set the remaining options (i.e., password, student feedback, 

 The program provides numerous options that allow you to customize the online 
led 

question order, and reports) for the online test. 

testing experience for your students’ needs. Click the Help button to view detai
information about the online testing options. 
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7. Review the test summary information and click the Save button to save the online 
test to your local area network (LAN). 

You can set the 
default folder 
using the 
Preferences 
option in the Edit 
menu. 

  

 

 

 Note: When you save the online test, the program saves a specially formatted copy 
of the test (with an .eot extension) to the location you specified. Remember that 
your students must access the test file on the local area network (LAN). If you saved 
the test to your hard drive, you must copy the online test (.eot, not .tst) to your 
network. 

8. If your test includes links to any multimedia files, you must copy those files 
manually to the same location as the online test. 

Students can now take the online test. See the Take a Test with the Test Player 
section. 

IMPORTANT: Preview the online test to make sure that everything is working. If you 
notice an error, make changes to the original test and publish it again. 
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Create an Online (LAN) Test with a Roster  
With the ExamView Assessment Suite, you can easily track student test results. When 
students take an online test, the program automatically scores the objective questions 
and stores the information in a database. Then you can produce a variety of reports 
and/or copy the results to your gradebook. 

 
To create an online test with a roster, you must first build and publish the online test 
using the ExamView Test Generator. Then, you must complete the process by 
creating an assignment in the ExamView Test Manager program. 

To create a test, publish the test, and track results for selected students…  

1. Start the ExamView Test Generator and create or open a test. 

2. Click  or choose Publish Online Test from the File menu. 

3. Enter a test title. 

4. Choose the Publish the test to a local network for use with the ExamView Player 
option and click the Next button. 

 

 

 

 

 

 

 

5. Choose the Allow access to students in a particular class option and click Next. 

6. Review the summary information and click the Save button to save the online test. 

 Note: When you save the online test, the program saves a copy of the test (with an 
.eot extension) to the location you specified. Remember that your students must 
access that location on the local area network (LAN). If you saved the test to your 
hard drive, you must copy the online test (.eot, not .tst) to your network. 

manually to the same location as the online test. 

If you include 
open-ended 
questions, it is 
easy to score 
student responses 
manually. 

7. If your test includes links to any multimedia files, you must copy those files 
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To assign an online test to a class… 

1 Start the ExamView Test Manager (if necessary). 

After you publish an online test, you must complete the process by creating an 
assignment for that class. 

. 

 

3. Click 

2. Open a class file. 

 or choose the Create New Assignment option from the Assignment menu. 

4. Enter the assignment name, category, term, and date. 

 

 

 

 

5. o k (LAN) option to 
identify how you will administer the test. Click the Next button. 

6. Select the file name that corresponds to the test 
you published in the ExamView Test Generator. 

7. You can allow your students to complete the 
test multiple times or over multiple sessions. 
Select the appropriate option(s) and click the 
Next button. 

 
over multiple sessions, the program will save 
their work and let them continue where they 
left off in a prior session. 

 

 

 

 

 

r Choose the Online test delivered over a local area netw

Select an ExamView 
online test (.eot), 
not a regular test 
(.tst) file name. 
 
You can preview a 

If you allow students to complete an online test 

test to make sure it 
is the right one. 
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8. Follow the steps to set the remaining options (i.e., password, student feedback, 
question order, time limit, and reports) for th

 
you to customize the online 

lick the Help button to view detailed 

 

 

 

 

 

 

 

 

9. Review the summary information and click the Finish button. 

After you create the assignment, it appears in the ExamView Test Manager work 
area. Notice the highlighted area in the figure below shows the assignment title, 
date, category, term, and possible points.  A placeholder (--) is set for each 
student’s score.    

 

 

e online test. 

 The program provides numerous options that allow 
testing experience for your students’ needs. C
information about the online testing options. 
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10. You should preview the online test to make sure that the test itself and online 
settings are correct. 

IMPORTANT: To preview a test with a roster, start the EV Test Player and use o
of your student’s IDs to access the test. When you finish, go to the ExamView Test 
Manager. Open the class file, select the assign

ne 

ment, and choose the Get Results 
from a LAN Test option. You should see the score for that student. Next, highlight 

esults from the Student 
just previewed. Be sure to 

 menu to apply the updates to the 

 

e classes. Simply open another 
int to the same online test when you 

udents’ IDs are unique across all 

online settings (e.g., change the 
se the Edit Assignment 

Information option from the Assignment menu.  
. before

(select) the student record and choose Clear Student R
menu. Be sure to clear the results for only the test you 
choose the Update Online Tests option in the File
online test. 

Notes… 

• You can assign the same online test to multipl
class file and create an assignment. Po
create the assignment. Make sure that your st
classes. 

• If you need to make any changes to the 
password, edit the reporting options, etc.), choo

• If you notice mistakes in questions, misspelled words, etc  any students 
take a test, make your changes to the original test and publish it again. 
IMPORTANT: You must delete the assignment from the class and then create
new one.  Otherwise, the answer key and other information will not match t
online test. 

• If you notice m

 a 
he 

istakes in questions, misspelled words, etc. after any students 
take a test, you cannot make changes to the test. However, you can adjust the 

Edit Assignment 
Questions tab and 

e anytime 
the actual 

points earned to adjust students’ scores as needed. 
• If you identify an incorrect answer or point value, choose the 

Information option from the Assignment menu. Click the 
change the information. You can change an answer or point valu
without re-publishing the test.  These changes are not updated in 
test, but they are applied to the students’ results. 
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Take a Test with the Test Player   
at you administer onFor tests th  your local area network (LAN), students must use the 

ExamView Test 
sur
(fu

You , 
com any 
obj t 
ma
sec ults from a LAN Test. 

n online test… 

1. 

2. Ent

 

 

 
 

3. Select the test and click the Next button. 

If you do not see the test listed, click the Folder 
button to change the location (if necessary). The 
program will show only those tests that the student 
may access. For example, if you set a date range 
when the test is available, you will not see the test if 
the current date is not in that range. 

Player to take the test. Before your students can take the test, make 
e that the program is installed on your network and that students have read/write 
ll) access to the folder where the test is located. 

 can include any question type (multiple choice, true/false, numeric response
pletion, essay, etc.) on an online test. The program automatically scores 

ective (e.g., multiple choice), completion, or numeric response questions. You mus
nually score any open-ended (e.g., essay) questions as described in the next 
tion—Get Res

 

To take a

Start the ExamView Test Player program. 

er the student name and ID. Click the Next button to continue. 

 

 

 

 

 
 
 
 

If a student 
enters their ID 
incorrectly, no 
tests will appear 
in the list. 
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4. Review the test information and click the Start button to begin the test. 

 The ExamView Test Player displays one question at a time. Students can answer a 
question by clicking the radio buttons, clicking the choice buttons, or by typing a 
response. 

 

 

 

 

 

 

 

 

 ttings. For example, if 
Score button appears 

 e cted the appropriate 
settings. 

5. Respond to each question. Click the Next button or 
press Page Down to go to the next question. 

6. Click the End button when you are finished. 

 rt 

7. 

 

 

The options available to the student depend on the online se
you set the option to allow students to check their work, the 
at the bottom of the window. If you set a time limit, a timer is displayed.  

Get in the habit of previewing a test to make sure that you s le

You can set an 
option to show 
the end-of-test 
report and 
whether students 
can print the 
report. 

Depending on the reporting options you set, a repo
will appear.  

Click the Exit button to quit the program, or click 
the New button to start a new test.    
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Get Results from a LAN Test 

 

incl
the questions and record the points earned. 

To g

1.

2. 

3. 

After your students take an online test, the next step is to get the results into the 
ExamView Test Manager. When you perform this step, the program reads the results
and stores the data in the class record. If your test 

udes open-ended questions, you must manually score 

et results from a LAN test… 

 Start the ExamView Test Manager program. 

Select (highlight) the assignment for which you want 
to get results. 

Click 

Remember, that 

 or choose the Get Results from LAN Test option from the Assignment 
menu. 

The program automatically locates the online test file (with an .eot extension) and 
reads the results from it. If you moved the file, you must locate it. 

4. If your test included open-ended questions or you need to change a student’s score, 
select the assignment and choose the Edit Scores option from the Assignment 
menu.  

 The Edit Test Scores window shows you how your students answered each question 
and the points earned. Select a student. For open-ended questions, select a 
question. The student’s response appears for your review. Read the response and 

  

 

 

 

enter the points earned. Click the Next button to move to the open-ended question 
for the next student. You can change the points earned for any other question too. 

 

 

 

 

 

student results 
are stored only 
for online tests 
that you assigned 
to a class. 
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PUBLISH A TEST TO THE EXAMVIEW TEST-HOSTING SERVICE  

few 
 over when and who takes a 

e costs. 

rs of the ExamView Assessment Suite) offers an 
optional test-hosting service on an annual subscription basis. For more information and 

. 

lf-grading practice test in just a few steps that your students can 

in  
art. 

e by standard or 
learning objective. 

Using the ExamView Test Generator, you can publish an online test in several ways. 
One of those ways is to publish a test directly to an Internet test-hosting service. A 
test-hosting service offers these advantages: (1) publish to
mouse clicks; (2) results tracking and reporting; (3) control
test; and (4) no additional hardware or maintenanc

 the Internet with just a 

FSCreations, Inc. (the develope

pricing, visit our website at www.fscreations.com

With the test-hosting service, you can… 

• Publish a se
take from anywhere they have access to a computer and the Internet. 

• Adm ister homework and automatically score it without any additional effort
on your p

• Deliver benchmark tests to a class or an entire school. 
• Produce numerous reports that let you track student performanc

O eck ther companies such as your textbook publisher may offer an online service. Ch
with your sales representative or visit their ave website for more details. If you do h
access to a third-party service, follow the steps below to publish a test. However, be 
sure to choose the appropriate option from the Publish test to: pop-up menu. After 
you publish the test, refer to the instructions for that service to administer the 
a V Test ssessment. IMPORTANT: You will not use the ExamView Instructor Center or E
Center to administer tests published to another service.  

 

Register for the Test-Hosting Service 
must purchase a certificate 

e ster, you receive an 
instructor ID and a password. 

To register for a test-hosting account… 

1. Visit www.fscreations.com/examview.php and click 
the Instructor Center test-hosting link. 

2. Click the Register link and follow the instructions to 
sign up for the service. 

Be sure to record your instructor ID and password. 
You will also receive an email with this information. 

3. Quit the browser when you finish. 

Before you use the ExamView Test-Hosting Service, you 
number and then use it to register for an account. When you r gi

After you register 
online at the 
FSCreations 
website, you can 
change your ID 
and/or password. 
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Publish a Test 
Publishing a test (regular or self-scoring) using the ExamView Test-Hosting Service is 
a very simple process. Within minutes, you can create a test for students to take 
online. Test results are available immediately after your students complete the test. 

To publish a test… 

1. Start the ExamView Test Generator, and create or 
open a test. 

2. Click  or choose the Publish Online Test option 

3. Ent

4. S l

t

5. Ent and password, and then click the Next button. 

 

 

 

 

s
how many times a student 

ss to anyone. 

assign the test to a class. You 
om another file. 

If you have an 
account with 
another service, 
select it from the 
Publish test to: 

 

from the File menu. 

pop-up and enter 
the appropriateer a title for the test. 

e ect Publish test to: with the pop-up showing 
ExamView Test-Hosting Website. Click the Next 
u ton to display the log in screen. b

er your instructor ID 

 

 

 

 

ID and password.  

6. Select the option to determine who may access the test. 

You can allow anyone to take the test or control acce
class. If you do not care about getting student results or 
takes a test, allow acce

s to students in a particular 

If you want to track your students’ results, you must 
can create a roster or import student names and IDs fr
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7. Set a password for the test and click the Next button. 

 

 

 

 

 

8. ons.  

 the test to 
the website. 

mail that confirms you published the 
ctions that you can provide to your 

 

 

After you publish 

 

a test, you can 
preview it and 
edit many of the 
settings online at 
the Instructor 
Center.  

 
Select the remaining online test opti

9. Review the summary information, and click the Publish button to upload

After you publish the test, you will receive an e
test successfully. The email also includes instru
students so that they can access the test. 
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Access the ExamView Instructor Center 
The ExamView Instructor Center provides access to tests you publish via the test-

ing a web er 
connected to the Internet.  

Using the ExamView Instructor Center, you can… 

• Preview a test. 
• Change selected test settings. 
• Edit, change, or delete students. 
• Access numerous student reports. 
• Delete tests. 
• Update your account information (ID, password, email address, etc.). 

 

To access the ExamView Instructor Center… 

1. Go to the www.fscreations.com/examview.php website. 

2. uctor Center link. 

3. 

4.  view reports, update account 
information, etc. 

 

 

hosting service. Access the Instructor Center us browser on any comput

Click the Instr

Enter your instructor ID and password to log in to the Instructor Center. 

Link to the desired option to manage tests,
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Take a Test via the Internet  
Students can take a test using any computer (Windows or Macintosh) connected to the 
Internet (e.g., at school, in a lab, or at home). When you are ready for students to 
complete an online test, direct them to the www.evtestcenter.com website.  

To take an online test… 

1. Go to the www.evtestcenter.com website. 

2. Enter the Instructor’s ID. 

After you log in, you will see a list of the available 
tests. 

3. Highlight a test and click the OK button. 

 

 

 

 

 

 

 

 

 

 

4. Enter the student ID or name, and enter the test password. 

IMPORTANT: If you published a test with a roster, your students must enter the ID 
you assigned to them. If you allowed anyone to access the test, students must enter 
their name. 

5. Complete the test and choose to end the test. Click  to submit 
and/or view the results. 

When you publish 
a test, you get an 
email with a link 
to the test. 
Students can use 
that link to skip 
the log in 
process.  



  
  

Get Results from an Internet Test 

our 
 or Internet) into one convenient location.   

 your  
s described in the previous sections. 

Administer the test or homework assignment to your students. 

IMPORTANT: Getting the results from an Internet test is optional since you can access 
man Center. With the test-hosting 
service, you can view student results and generate numerous reports online. You do 
not have to download the results into the ExamView Test Manager.    

To get results from an Internet test… 

1. 

2.

3. gn
information and identify the test (.tst) for the program to read the ans er key and 
other question information (standards, references, etc.). 

4. Highlight the assignment. Click 

Using the ExamView Test Manager you can download test results from the Instructor 
Center to your desktop. Then, you can produce reports using the reporting options 
provided in the ExamView Test Manager.  You can combine results from all of y
assignments (paper, LAN,

Before you can download the results, publish
Generator using the various online test setting

 test with the ExamView Test

y reports online at the ExamView Instructor 

Publish a test to the test-hosting service, and administer the test to your students. 

 Start the ExamView Test Manager (if necessary) and open a class.  

Create an assignment if you have not already done so.  Enter the assi ment 
w

 or choose Get Results from Internet Test. 

5. Enter your instructor ID and password, and click Next. 

6. Select the Internet test from the list provided and click Finish to get the results. 

 The ExamView Test Manager downloads all of the students’ responses and results 
from the Internet test-hosting site. If your test includes open-ended qu stions or 
you need to change a student’s score, select the assignment and choos  the Edit 
Scores option from the Assignment menu. 

 

e 

ou use to create an assignment in the ExamView Test Manager. 
• You can administer a test using any combination of paper, local area network 

red via a LAN, you cannot change the test settings in the 
ExamView Test Manger.  You must make any changes to these settings and the 
class roster online at the Instructor Center.  

e
e

Notes… 

• When you publish a test, be sure to save a copy locally on your computer.  Th
test you publish online must match exactly (answer key, question order, etc.) 
the test y

(LAN), or Internet testing options. 
• Unlike tests administe
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PREPARE REPORTS FOR PAPER AND ONLINE TESTS  

Class Roster 

Performance Summary 

 

t 
Learning Focus 
Performance Summary 

For he information included 
in the report. Using the filter option, you can generate reports for selected students or 

rit
 

Class Reports 
d 

evaluate your students’ performance. Depending on your needs, you may prepare one 
 

asse e 
lea g 
opt is section includes a brief overview and 
 sample of each class report. 

The ExamView Test Manager enables you to prepare a variety of reports based on 
your students’ assignment results data. You can print a report for a single assignment, 
a group of assignments, or all assignments. You can also easily customize a report to 
include selected students filtered by various criteria. Many of the reports include 
graphs and charts that provide a visual analysis of the data. 

 

Use the ExamView Test Manager to generate the following class and reports. 

 

Class Reports   
Assignment Results 
Class Assignment Summary 
Open-Ended Responses Worksheet 

Student Reports   
Assignment Results 
Assignment Review 
Student Progress Repor

Item Analysis Summary 

Learning Focus  

Class Performance Progress Chart 

 

 each report, you can choose reporting options to control t

a group of students that match the c eria you set.  

 

The ExamView Test Manager provides numerous reports to help you understand an

or more of the class reports to provide useful performance data that allows you to
ss your class as a whole and then determine appropriate strategies to achieve th

rning objectives/standards. With each report, you can control numerous reportin
ions to customize the report as desired. Th

a
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Assignment Results 
The 

n) and a 
raph of the frequency distribution. When you choose this report, you can control 

vario tions. For example, you c  all of the student 
informati clude the ID or alias for each stude

 

Usin nment see how the 
majority of the students performed on the as data provides 
usef  reference; you can pproximate amount of 
time required for the students to complete the  might use the 
Assig ort to post the results of an assignment. 

 
 

 

Assignment Results report provides performance data for each student for a 
particular assignment. The report includes the student’s name, ID, points earned, and 
percentage achieved. For online test, the report also includes attempts to complete 
the assignment, the start time (date and time), and the duration of the assignment 
(i.e., the total time to complete the assignment).  

 

The report also includes a separate page with the assignment statistics for the entire 
class (i.e., median, mean, low score, high score, range, and standard deviatio
g

us reporting op an choose to show
on or you can in nt.  

g the statistical data in the Assig Results report, you can 
signment. The duration 

ul information for future  calculate the a
assignment. Finally, you

nment Results rep
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Class Assignment Summary 

ver time, the Class Assignment Report provides useful data to help you assess the 

The Class Assignment Summary report provides the average for each student for all 
assignments or for a particular category (i.e., tests, quizzes, etc.) of assignments. You 
can summarize the data for all terms or one term. For example, you can create a 
report that shows each student’s average for all tests in the first term.  

 

O
performance of your class as a whole. From this information, you might be better 
equipped to assess the effectiveness of your teaching strategies and the associated 
assignments as they relate to the learning objectives/standards for the class.  

 

 In the Class Assignment Summary report, the shaded area (Note: ) shows the 
edian performance range for the class and the diamond (m ) shows the exact student 

average.  
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Open-Ended Responses Worksheet 

et the results 
into the ExamView Test Manager. This process reads all of the student responses 

. After you complete the worksheet, use the Edit Scores option to enter the results 

 You can score open-ended questions anywhere and then enter the scores 
to the ExamView Test Manager at a convenient time. 

The Open-Ended Responses Worksheet report allows you to score the open-ended 
questions that your students complete as part of an online test. Follow these steps to 
score open-ended questions and enter the scores into the ExamView Test Manager.  
1. After all of your students finish an online test, use the option to g

for the assignment including the open-ended questions (essay, short answer, etc.). 

2. Print the Open-Ended Responses Worksheet. The report includes the open-ended 
responses for each student and space for you to write the points earned for each 
question.  

3
into the program. 

You can use the Open-Ended Responses Worksheet report to work away from your 
computer.
in
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Item Analysis Summary 
The Item Analysis Summary report provides the percent of the class that answered 
each question correctly. For multiple choice questions, the report also shows the 
percent of the class that selected each response (or answer choice).  
 
Yo  can use the response analysis in the Item Analysis Summary to identify areas in 

ich you may want to focus a reteaching activity so that you can better address 
u

wh

stu
points to a problem with the question. For example, suppose students answered a 

occ recorded an incorrect answer for the question, the question was 

udent responses are evenly 
for all of the answer choices, the analysis may indicate that students 

 
lected the correct response at 65% followed by 30% for the next response. This 
sponse analysis data may point to a common mistake students made in determining 
e correct answer for the question. On a question-by-question basis, you should look 
r similar patterns; such information can provide insight into your students’ 

nderstanding of the material covered by the assignment.  

Note: In the Item Analysis Summary report, an indicator (>) appears to the left of a 
question that more than 30% of the students in the class answered incorrectly. 
  
 
 

 

particular learning objectives/standards. For questions with a high, correct response 
rate, you can use the information to validate the question. On the other hand, if 

dents consistently answered a question incorrectly, you can assess whether this 

question overwhelmingly (e.g., 60%) with an incorrect response. This may have 
urred because you 

unclear, or you did not cover the information adequately in class. 
 
If, in a particular multiple choice question, the st
distributed 
randomly selected a response. If, in another multiple choice question, students
se
re
th
fo
u
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Class Roster 
The Class Roster report generates an alphabetical list of the students in a particular 
class. You can create a filter to include all of the class or selected students. 
Additionally, you can customize the Class Roster report by choosing to include the 

pplemental student information (i.e., ID/alias, password, grade, date of birth, su
sociological/economic, etc.). 

 

You might use this report to have a printed record of the ID/alias and password for 
each of the students in each class. You could then conveniently reference this printout 
if a student forgets their ID, alias, or password. However, to maintain privacy of the 
IDs, you would want to keep the printout in a safe place where students and others 
could not access the information. 
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Learning Focus 

% - 70%). The program produces a report that shows 
ach standard (or learning objective), the number of questions assessed for that 

Note: The shaded area ( 

The Learning Focus report provides a wealth of information to help you identify areas 
where your class (as a whole) needs to focus their learning efforts. To use this report 
effectively, the assignments you create must consistently include data for one or more 
of the following fields: learning objective, local standard, state standard, or national 
standard. 

 

One of the key advantages for using the ExamView Test Manager is that you can easily 
gather performance data over multiple assessments. The report shows the number of 
items for each standard. That way, you can gauge whether a standard was adequately 
covered. You can select one or more assignments by category or by date. You must 
also identify a focus range (e.g., 0
e
st

 

andard, class average, and how many students are in the focus range. 

 ) shows the performance for the median 70% of the 

ores 
represents 14 students or 70% of the class. The diamond ( 

students in your class. For example, if there are 20 students in your class, the top 3 
scores (15%) and lowest 3 scores (15%) would not be included. The range of sc

 ) shows the actual class 
average. Use the graphs to see how the majority of students performed. If the area is 
relatively short, students’ scores were similar. 
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Performance Summary 

as attained.  

for the class 
ssignments, and you can set an appropriate proficiency target (e.g., 70% and above) 

t a p

The Performance Summary report provides a summary of your class’ performance for 
all class assignments in a category over a specified date range. The Performance 
Summary report lists a learning objective/standard, the number of items (i.e., 
questions) that assess that objective/standard, and the proficiency level that the class 
as a whole h

 
To use the Performance Summary report effectively, you must consistently include 
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

 
You can customize the Performance Summary report to generate the performance 
data that best meet your needs. You can select the date range 
a
for the class assignments a articular time in the term. As an example, you might 
set the proficiency target at 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the proficiency target at 80%. 
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Class Performance Progress Chart 
The Class Performance Progress Chart report shows at a glance how each student is 
performing on each of the learning objectives/standards for all assignments in a 
category over a specified date range. The report lists a learning objective/standard, 
the number of items (i.e., questions) that assess that learning objective/standard, and 
a proficiency indicator for each of the students.  

the questions they 
rovide.) 

 
To use the Class Performance Progress Chart report effectively, you must 
consistently include question information for one or more of the following fields in 
each of the items you create: learning objective, local standard, state standard, or 
national standard. (Many publishers include this information for 
p

 
To customize the Class Performance Progress Chart, you can set the category of 
assignments, the date range of the class assignments, and the proficiency level based 
on your performance criteria. The report shows one of three icons ( ) to 
indicate each student’s performance on each of the learning objectives/standards. 
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Student Reports 
The ExamView Test Manager provides five reports that highlight each student’s 
individual performance for one or more assignments. This section includes a brief 
overview and a sample of each student report.  

 

Assignment Results 

ct the option for performance results for learning objectives/standards, the 
ssignment Results report also includes each learning objective and the following 

ublishers include this information for the questions they provide.) 

 

The Assignment Results report reflects a student’s performance for one assignment. 
The report includes the following information: assignment average, points earned for 
each question, and the student’s response for each question.  

 
If you sele
A
performance data for that learning objective/standard: the average, points earned, 
the proficiency level, and the specific questions in the class assignment. To use the 
Assignment Results report effectively, you must consistently include question 
information for one or more of the following fields in each of the items you create: 
learning objective, local standard, state standard, or national standard. (Many 
p

 

You can use this report to identify each student’s proficiency level for each of the
learning objectives/standards for each assignment. This information may also help you 
to identify areas in which a student may need remedial work. 
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Assignment Review 
The Assignment Review report provides a tool to help your students understand the 
mistakes they made on an assignment. For each question answered incorrectly, the 
report shows the following: points earned, student’s response, correct answer, 

, study tip, and focus area (depending on the explanation
  

information available). 

nt Review report effectively, you must consistently include extra 

estion. Students, in this 
xample, could use the report to refer to the specified pages in their textbook as they 

To use the Assignme
question information for each of the items you create. (Many publishers include this 
information for the questions they provide.) For example, a study tip such as Refer to 
pp. 23-25 is the information in the Reference field for a qu
e
review the questions that they answered incorrectly. 
 

Students can use the Assignment Review report to review the completed assignments 
and to learn from their mistakes. 
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Student Progress Report 

 total 
oints earned out of the total possible points, the equivalent percent, and the class 

The Student Progress Report shows a student’s progress for one or more terms. The 
report organizes the results by term and provides the following information for each 
assignment: assignment description, date assigned, category, points earned, percent 
achieved, and class average. A summary shows the term average by listing the
p
average.  
You can use the Student Progress Report to depict the student’s progress over time. 
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Learning Focus 
The Learning Focus report identifies areas where a student needs to focus his/her 
learning efforts. Based on a proficiency level you set, the report lists the learning 
objective/standards that a student has not mastered. For each of the learning 
objectives/standards the student has not yet mastered, the Learning Focus report 
lists the learning objective/standard, the associated number of items, the points 
earned on items, and the proficiency level that the student has attained.  

ou can customize the Learning Focus report to generate the performance data that 

e date range for the assignments. You can set an appropriate focus range (e.g., 0% - 
70%) for the class assignments at a particular time in the term. As an example, you 
might set the focus range at 0% to 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the focus range to 0% to 80%. 
 

You can use the Learning Focus report to help a student know exactly what to study 
in order to attain mastery level on the identified learning objectives/standards.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Note:  The shaded area ( 

 

Y
b
th
est meet your needs. You can select one or more class assignments by category and 

 ) shows the performance for the median 70% of the 
students in a class. e 20 students in a class, the top 3 scores 
(15%) and lowest 3 scores (1 would not be included. The range of scores for 14 
students (70%) would be ed. The diamond ( 

For example, if there ar
5%) 

 represent  ) shows your student’s actual 
performance. Use the graphs to see how a student performed in relation to his/her 
class. For example, if the diamond appears near or past the right edge of the shaded 
area, the student’s performance is in the upper range for the class.  If the shaded area 
is relatively short, students’ scores were similar. 
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Performance Summary 

ach learning 
bjective/standard.  

 

 

The Performance Summary report shows at a glance how a student is performing on all 
learning objectives/standards for all assignments in a category over a specified date 
range. The Performance Summary report lists each learning objective/standard, the 
number of items (i.e., questions) that assess each learning objective/standard, a 
proficiency score for each learning objective/standard, whether the student is 
proficient based on the proficiency target, and the average for e
o

To use the Performance Summary report effectively, you must consistently include
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many
publishers include this information for the questions they provide.) 

You can use the Performance Summary report to identify specific learning 
objectives/standards where the student needs to focus his/her learning efforts.  
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Print a Report 

After ExamView Test Manager prepares a report, you can print the report in just a 
few simple steps. When you are ready to print a report, follow these general 
instructions. Numerous report options allow you to customize the information that 
appears on the printout.  For detailed instructions and options, see the corresponding 
help topic in the application. 

To print a report… 

1. Click the Report menu and choose a report. 

2. Select the report options. 

3. Click the OK button to display the report. 

4. While viewing the report, click the Print button to 
send the report to the printer. 

 

 

Export Results to a Gradebook or Another Application 
The ExamView Test Manager lets you export the students’ results data for an
assignment. You can export summary data (e.g., student name, ID, and percentage) or 
detailed data (e.g., student information, all responses, answer key, etc.). With the
export option you can export student results in order to import them into your 
gradebook or a spreadsheet. For more advanced users, you can export the results for 
use with a student information system. 

To export the results for an assignment… 

1. Select an assignment. 

2. Choose Export and then select the Current Assignment as Text or Current 
Assignment as XML option. 

 Use the as Text option to export results for use with a gradebook or a spreadsheet 
program. Use the as XML option to export results to a student information system. 

3. Set the options (if necessary) and then enter a file name. 

 

 

Note: You can also use the Copy All Class Records option in the Edit menu to copy 
all of the information in the work area.  Then, you can paste that information into a 
spreadsheet document. 

You can set a 
filter to print 
only selected 
students based on 
various criteria.  
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PUBLISH AN INTERNET (HTML) TEST TO YOUR OWN WEBSITE  

Publishing an HTML test is a quick way to create an 
r, these disadvantages exist: (1) you 

must have your own website and know how to upload 
and who 

may access a test; (3) results are not stored in a 
er time; and (4) getting 

results via email can be unreliable due to network 

e
inst how to publish an Internet (HTML) test. 

 and create or open a test. 

Using the ExamView Test Generator, you can publish any test as an HTML document. 
You can choose to create a self-grading study guide or a test that will send student 
results to you via email. After you publish the test, you must copy the files to your 
website so that your students can access the test. 

online test. Howeve

files; (2) there are no settings to control when 

database for access at a lat

settings and spam filters. 

For many situations, the HTML testing features provide a 
an acceptable solution to meet a variety of onlin

ructions in this section to learn 
 testing needs. Review the 

 

Publish an Internet (HTML) Test 
Follow the instructions below to set the features for the online test and save it to your 
hard drive. 

To publish an Internet test… 

1. Start the ExamView Test Generator

2. Click  or choose Publish Online Test from the File menu. 

est as an HTML document to your hard drive option. Click 
the Next button to display the test options. 

 

 

 

 

 

3. Choose the  Save the t

 

 

The ExamView 
Test-Hosting 
Service provides 
a more robust 
Internet testing 
and study 
solution. 
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4. Choose to publish a study guide or a test and click the Next button. 

 A study guide is a self-grading test. You can choose 
to show the rationale, feedback, and reference if 
your test includes this information. Doing so makes 
the study guide a true learning experience rather 

nt his/her results after 
udent name and his/her 

When you publish an online test, the ExamView Test Generator saves an HTML file 
ages are stored in a folder named similar to 

 
 

 

 

 

6. ts to your website. Do not change 

 

website and set a hyperlink, 
process varies depending on your 

7. 

Then, click the Grade & Submit 
. It’s very easy to enter the 

not receive any emails. 
 

than just telling the students that an answer is right 
or wrong. 

 Choosing a test allows students to take it online, and 
you receive a separate results email for each student. Y
email address. You also have the option to show a stude
completing a test.  The results email will contain the st
score. 

ou must include a valid 

5. Click the Save button to save the HTML document and image files to your hard 
drive. 

and all of the supporting images. The im
the test file.  

 

 

 

 

Student feedback 
can include a 
hyperlink to 
remedial learning 
material. 

Copy the HTML file and the folder with its conten
anything including the folder name. 

Note: If you do not know how to copy files to your 
contact your technology support person. The 
particular system. 

Preview the test before your students take it.  

For tests, answer some or all of the questions. 
button and make sure that you receive a results email
wrong email address. Doing so will cause you to 
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Take an Internet (HTML) Test 
A er you publish an HTML test and copy it to your websi
test anytime from anywhere they can access the Inte

dents with the website address (URL) for them to ac

take an Internet test… 

Start your 

ft t he 
rnet. You must provide your 

stu cess the test. 

To 

1. web browser. 

to a page with a hyperlink to 

 

 
 

 

 

 

 

 

 

 

3. 

4. 

ck Your Work button for a study 
guide or the Grade & Submit button for a test. 

 

e, your students can take t

2. Enter the website address to go directly to the test or 
the test.  

 

 

 

 

When the test appears, enter your name (and email/ID if requested).  

Complete the test. 

5. When you finish your online work, click the Che

Note: For a test, you will receive a results email for each student shortly after the
student clicks the Grade & Submit button. 
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EXPORT TESTS TO WEBCT AND BLACKBOARD  

 test, choose to 
export it, and a wizard will guide you through the process. 

The ExamView Assessment Suite works with both the WebCT and Blackboard course 
managements systems. You can easily upload a test from the ExamView Test 
Generator to either one of these applications. Simply create your

                                                                    

 

1.  test. 

2.

3. 

pears while you are 

 

To export a test… 

 Start the ExamView Test Generator and create or open a

 Choose Export from the File menu, and select either 
WebCT or Blackboard. 

IMPORTANT: The export option is only available on 
the Windows version. 

Follow the instructions in the wizard to upload the 
test. 

For step-by-step instructions, click the Help button that ap
working with the wizard. 

Be sure to check 
the FSCreations 
website for free 
updates to the 
export program. 
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APPENDIX   

 

Technical Support 
Before contacting technical support, please check the following: 
 

• Is your computer working properly? Try some other software, which you know is 
working, on the same computer. 

• Try the software on another computer. 
Can you repeat the problem? Does r at the same po
time? 

 as quickly as possible, have the following information available 
pport: 

• Brand, model, and configuration of the computer you
0.2, etc.)  

f any error message 
 
Bef e support forum. Go to our 
we .com) and click the support link.  
 

um, send us an email at 
support@fscreations.com. If you need to reach us by telephone, you can find the 
number on our website in the support area. 
 
 

Using the ExamView Assessment Suite with Other Applications 
Many other products work with the ExamView Assessment Suite software and its 
content. For example, you can deliver a practice test that works with a quiz show 
program or use the test on a handheld (e.g., Palm or PocketPC). The ExamView 
Assessment Suite also works with several bubble sheet scanners to make grading your 
tests quick and easy. 
 
For a complete list of the products that work with the ExamView Assessment Suite, go 
to our website (www.fscreations.com). 
 

• the problem occu int each 

 
In order to help you
before you contact technical su
 

• Version of the software (e.g., 5.01) from the start-up splash screen 
 are using 

• System version (Windows XP, Windows 2000, OS X 1
• The exact wording o

ore you contact us, you may want to search our onlin
bsite (www.fscreations

If you cannot find a solution to your problem on the for
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License Agreement 

Creations, Inc. 
28 

OFTWARE LICENSE AGREEMENT 
1. N T
Suit  u only on the condition that you 
acc t e agreement. Your installation and use 
of t  
 
. OWNERSHIP AND LICENSE. This is a license agreement and NOT an agreement for 

all 
 this Agreement to make (the "Software"). Your 

ghts to use the Software are specified in this Agreement, and we retain all rights not 
exp
 
Not . Copyright law 
or a  
 
. PERMITTED USES. You are granted the following rights to the Software: 

ware on the hard disks of 
 single standalone computer (and you may install it on both an office and home 

 used 
iew 

twork server. 

 you have acquired this Software pursuant to a multiple-user site license, and your 
voice so indicates, you may install and use this Software on the hard disks of 

ou 
if a 

 on 

) Right to Copy. You may copy the Software for backup and archival purposes, 

. PROHIBITED USES. You may not, without written permission from us:  
 
(a) Use, copy, modify, merge, or transfer copies of the Software except as provided in 
this Agreement; 

(b) Use any backup or archival copies of the Software (or allow someone else, 
including another instructor, to use such copies) for any purpose other than to replace 
the original copy in the event it is destroyed or becomes defective; 

 
FS
621 Mehring Way, Suite 2
Cincinnati, OH  45202 
 

S
O ICE. We are willing to license the enclosed ExamView, ExamView Assessment 

or ExamView Pro software (the "Soe, ftware") to yo
ep  all of the terms contained in this licens
he software constitutes your acceptance of these terms in their entirety. 

2
sale. We continue to own the copy of the software contained in this package and 
other copies that you are authorized by
ri

ressly granted to you in this Agreement. 

hing in this Agreement constitutes a waiver of our rights under U
ny other federal or state law or international treaty. 

.S

3
 
(a) Right to Install and Use. You may install and use this Soft
a
computer provided that both are for your personal use and will not be
simultaneously by other instructors). You may freely copy and distribute the ExamV
Player. You may also store the Player on a ne
 
If
in
standalone computers up to the number of computers specified in the invoice. Y
may install the software on a network server for access by multiple computers 
server license is identified on your invoice. 
 
If you have acquired this Software pursuant to a non-academic license as specified
the invoice, this Software may be used to present tests and study guides concurrently 
to multiple students, up to the number of students specified on the invoice.  
 
(b
provided that the original and each copy are kept in your possession. 
 
4
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(c) Disassemble, decompile or "unlock," reverse translate, or in any manner decode 
the Software for any reason; or  

(d) Sublicense, lease, or rent the Software. 
 
5. WARRANTY DISCLAIMER. WE DO NOT WARRANT THAT THIS SOFTWARE WILL MEET 
YOUR REQUIREMENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-
FREE. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, WE AND OUR 
DISTRIBUTORS EXCLUDE AND EXPRESSLY DISCLAIM ALL EXPRESS AND IMPLIED 
WARRANTIES NOT STATED HEREIN, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
 
Some states do not allow the exclusion of implied warranties, so the above exclusion 
may not apply to you. This limited warranty gives you specific legal rights, and you 
may also have other legal rights, which vary from state to state. 
 
6. LIABILITY DISCLAIMER. IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF 
PROFITS) EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  
 
Some jurisdictions do not allow these limitations or exclusions, so they may not apply 
to you. 
 
7. NOTICE TO UNITED STATES GOVERNMENT END USERS. The Software and 
Documentation are "Commercial Items," as that term is defined at 48 C.F.R. §2.101, 
consisting of "Commercial Computer Software" and "Commercial Computer Software 
Documentation," as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, 
as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 
227.7202-4, as applicable, the Commercial Computer Software and Commercial 
Computer Software Documentation are being licensed to U.S. Government end users 
(a) only as Commercial Items and (b) with only those rights as are granted to all other 
end users pursuant to the terms and conditions herein. Unpublished-rights reserved 
under the copyright laws of the United States. 

Manufacturer is FSCreations, Inc., 621 Mehring Way, Suite 228, Cincinnati, OH  45202. 
 
8. TERMINATION. This license and your right to use this Software automatically 
terminate if you fail to comply with any provisions of this Agreement, destroy the 
copies of the Software in your possession, or voluntarily return the Software to us. 
Upon termination you will destroy all copies of the Software and documentation. 
Otherwise, the restrictions on your rights to use the Software will expire upon 
expiration of the copyright to the Software. 
 
9. MISCELLANEOUS PROVISIONS. This is the entire agreement between us relating to 
the contents of this package, and supersedes any prior purchase order, 
communications, advertising or representations concerning the contents of this 
package. No change or modification of this Agreement will be valid unless it is in 
writing, and is signed by us. This agreement shall be construed and governed in 
accordance with the substantive laws of the state of Ohio. 
 
575872.01 
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